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Professional Flipbook Maker with Multimedia
PDF to Flipbook

About Flip Book Maker for PDF Pro

Flip Book Maker for PDF Professional is the
professional version of the original Flip Book Maker
for PDF. The professional version does not only
include all the features of the original version, but
with more powerful functions to make more
outstanding and interactive virtual flipbooks.
Empowered with the "Edit Pages" function, Flip
Book Maker for PDF Pro enables you to design and
decorate every single page with multimedia and
other new applications. You can embed video,
audio, flash, YouTube video, image albums; add
page link, web link, e-mail link. And you can also
automate the interactive flipbook conversion in

command line mode.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Software features

Powerful page-editing function

1.

Add links to open a link, call JavaScript function, open flash window and
photo slideshow, etc;

Embed flipping pages with video, audio, flash, YouTube video;

Insert image (album) to design photo slideshow;

Add button to call new actions(go to the appointed page, open a link, play
audio, etc);

Set printable area for your readers to print out coupons directly;

Copy and paste selected objects (link, video, flash, image, etc.);

Delete the unwanted objects;

Zoom in and zoom out while editing the pages.

Optional output formats:

1. HTML makes it possible to be viewed online or just offline;

2. Zip and Exe make it easily to be stored and sent via emails;

3. App format enables you to view the flip book separately on Mac;

4. Mobile versions can run on your iPad, iPhone, Android mobile phones...;

5. Burning to CD allows it to play on computer with defined title and
automatically play mode.

Setting control tools:

1. Convert or batch convert the PDF files to interactive virtual flipping book;

2. Define the language for your flipping book or use two or more kinds to make
languages switchable;

3. Choose a template(theme) from the 4 templates(classic, float, neat and

spread);
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10.
11.
12.

13.
14.
15.
16.
17.
18.
19.
20.

Customize your own template;

Show or hide the toolbar or other buttons (home, full screen, help, share,
social share...);

Set password to retain access authorization;

Set permission for printing, downloading, (social) sharing;

Self or blank open window for home page and links;

Add background music and set looping time;

Font setting for flash, bookmark, buttons...;

Page shadow setting, left-to-right or right-to-left reading;

Zoom in & zoom out button makes it easier to view the stylish digital flipping
book;

Choose the Minime style that hides the toolbar;

Color setting for background, font, buttons, icons;

Edit book proportion and margin;

Insert page number and start page number;

Auto play setting allows it to play as soon as you open the flash flip book;

Add Google Analytics Integration to track the statistics;

Help button enables you to insert a file to show in the flipping book;

Add about button to show your company file and contact information.
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Interactive Virtual Flipping Book Features:

1.
2.
3.

10.
11.
12.
13.
14.
15.

16.

Open book in hard cover, or view from right to left;

Turn a page by clicking the page shadow;

Turn a page by dragging the corners;

Turn a page by sliding the mouse wheel;

Turn a page by clicking the "First/Last, Previous/Next Page" buttons;

Turn to a certain page by entering the page number;

Click button to play/stop the video, flash, audio, etc;

Click button to open a link or call JavaScript function;

Open a photo slideshow while mouse moves over;

View the flip book automatically with auto play;

Read the flip book in full screen;

Zoom in and zoom out to get a better view;

Download and print out the eBook;

Print out the appointed printable area;

Share the interactive virtual flipping book with others via e-mail, Facebook,
Twitter...;

Read the flipping book with portable devices like iPad, iPhone, Android

phones.
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Operations:

Easy Import:
1. Launch the program via the desktop shortcut | ;

2. Click the "Import PDF" icon }"'lL’ mpartfE to enter into Import PDF interface;

Source PDF File

E:\Flip Book Maker\Flip Book Maker for PDF Introduction. pdf Browse,, J [ DOpen it |

The Page Ranges to Import Watermark

@ Al pages 50 Place & custom text or image
" - Watermark{Stamp) to the file{s)

(") Custom range: Example:1,3,5,9-21

[¥] Quickly impart {Only import 10 pages to initial preview) Set Watermark

Page Quality

Quality And Size: Ingh quality larae file size v]

44, High values produce better page quality but require more disk space and more time to download.

[¥] tmport bookmark [¥] 1mpart links [ Enable search [¥] Detect wide pages

Import Now

3. Click icon to choose PDF file from your computer;

4. Click [ B =il licon to open and see if it is the file you want to convert;

5. Choose to import all pages or custom range pages;

. SetWatermark |, . . .
6. Click wlcon to enter into watermark selection interface, choose

watermark(s) for the flipbook;
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Selete Watermark

Select one or more Watermark(s) Watermark Preview
| T — [Te— | -
[+ @ %o 2 & | Evewsyie ] Check Al o P
o Gom d{_coﬁ‘
Qo 28 a2
[F] CONFIDENTIAL [ F a . o
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Vel @ I
6" ] a_pd‘ a
e e
Text - CONFIDENTIAL Text - LOGO {left-top) I
& ca® o o™ |
a° B
1 -3 b |
d@
[ | 1503-0910:23:18 @l Pm': | @5-1\“ d‘_c,o‘“ G‘LO‘“ I
o 29 .
- o |
i e
||
Lo | [ conce |
2 watermarki(s) checke 1

7. Choose the output quality and size

Pages Quality and Size

Quality And Size:

High quality large file size
Medium guality medium file size
Low quality small file size
Lower quality smaller file size

High values
# but require m

8. Enable or disable the following functions:

E Import bookmarks to the flipbook so that your readers can find

the contents easily;

(71 1mport inks If there are links in your PDF files, the flipbook will retain the
links;

[VIEnablesearch  cpock this option to enable search functionality in created
flipbook.

[¥] Detect wide pages

This option can enable the PDF file to be presented in

two-page spread in output flipbook.

9. Click |con to enter into custom setting interface.
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Edit Pages

The most distinguish feature of Flip Book Maker for PDF Pro is the introduction of

"Edit Pages". You can eidt pages with multimedia such as video, audio, flash, and

even Youtube video.

E so Edit Pages

(1) Click

icon to enter page editing interface;

(2) Click icon to add links, draw a link box

v'Create real flipping effect book in
minutes

Create realistic Adobe Flash based page-flipping

animation book less than 10 minutes. No any

programming tricks need!

v'Publish online, email and CD
Publish your digital (electronic) editions such as
any type of publications, magazines, brochures and

catalogues to web sites, email even CD-ROM.

v'Keep PDF Hyperlink, Bookmark and Text
Imports hyperlink, bookmark and text from PDF
files. You can click the hyperlink inside to flip to
another page or go to a web page directly, browse
book/catalogues quickly with bookmarks, even
search your book because the text in PDF files has
been imported.

and then you will see the link properties:
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Lirk Properties

Action Options

Mo action,

. Action Options ]
Click . .

icon to enter the link action interface:
Action Options

Please

2 Dowrn @ Lp 8 Move

= Dot

Ple. lect an action type.

® Gotopage & Open alink @ Call Javascript function

™ Cpen Flash wWindow 8 Play Audio ® Photo Slidesh

LIRL:

Link Target:

Select an event to fire the related action(mouse down/up/move/over/out).

You can define the link action as "Go to page", or open an online webpage, or
even "Call Javascript function" to carry out your wanted interactive functionalities via
defining Javascript function, open flash window, play audio and photo slideshow.

@ Go to Page
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Select"Go to page" and define which page to go, for example page 4

50 To Page:

, click"OK", then you can go to page 4 directly by

clicking the page link.

®0Open a link

define link target as blank, self, parent or top and you will go to where you want.

Link Target:

Blank
SELF

Parent

Top

@ Call Javascript action

Write down javascript function text in the box and

make sure the Javascript wrote into the index.html page, then you can call the
javascript function by clicking the action link.
@O0pen a flash window

Select "Open a flash window", then the"Open Window Action Properties" box will

pop up.
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Open Window Action Properties

wWindow Type: Open the window to play a video
i} ‘,l'l.ll'ir' j Dy |: ar t =l t 0
S b colect The File

Fleaze choose the resource file

doy Caption:

Wi |j oy Hei I;.l h t:

Window Type: Open the window to play a wideo

Cpen the window to play a video

Window Contel Open the window to showe a SWFE(Flash)

Open the window to show some text

Select the window type and

then select the file from your computer to imput text content directly, define window
caption, width and height.
®Play Audio

Select an audio file and choose auto play or not;

I Select a Audio FiIe(MF‘BJ: m

®Photo Slideshow

Select"Photo Slideshow", then it will pop up the below interface:
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Photoes Information

LRL Action

Add Images

Add images from your computer, and press"OK". And when you clickthe link, the

photo slideshow will pop up.

(3) Add movie that plays FLV

Clik to add movie that plays FLV, and you will see the movie

box.and movie properties interface as below:
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Movie Properties

Select FLY Movie

IMovie: Blank

Color;

when click Play button

Stop Maovie: When leave the page

Select FLV movie and player skin color, define play and stop action, define
interface size.
(4) Add Image

CIick to add an image, you can choose an image from your computer and

define action options as above mentioned: go to page, open a link, call javascript
function, open flash window, play audio and photo slideshow.
(5) Add Sound

Click ' to add music to the flipbook. You will see the music palyer i‘l_‘"‘t ,
select sound from your computer and define mouse actions. When you open the

flipbook, just click j:J_"“c and the music will start to play.

(6)Add SWF

Click .to add SWF to the flipping page. Just select a SWF from and then
define proportion for the SWF.

Swi perties
Select a Swf

SWF: Blank

(7) Add Button

¥
Click . icon to add buttons to call new actions. Select an icon(SWF or image)
for the new action and select the action: go to page, open a link, call javascript
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function, open flash window, play audio and photo slideshow.

Button Properties
Select an Icon(SwF,Image)

Button: Blank

Action Options

(8) Add Youtube Video

m
Click icon to add Youtube video. Input Video ID and parameters, define

mouse actions and proportions, and you can see the Youtube video in the
flipbook.

YouTube Yideo Properties

1D

Wideo Parameters:

Plary Morvie: wihen click Play button

When leave the page

Stop Movie:

(9) Add Printable Area

=
Click icon to add printable area as coupon.
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Link Properties

Color: B over dlpha

Border Colar: Border Width:
Title:

Description:

If you want coupons in your flipbook, you can add printable area, just define color,
title, description and proportions for the coupon. And you readers can print it out
with ease.

After finishing editing the flip pages, just click "File=>Save And Exit", then all these
amazing functions will present in your filpbook.

Powerful Custom Settings

The powerful custom settings of Flip Book Maker for PDF Pro enable you to make
your flipbook in your favorite style: Template Selection, Tool Bar Settings, Flash

Display Settings, Flash Control Settings.

1. Template settings:

(1) CIickHicon to enter into template selection interface, choose your

favorite template and theme;
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J Choose a flipbook template here. (Double-dick to make & quick selection)
8 (More and more templates will be provided in future.)
£ Get More Themes Online
Classical Template enables you to show your page-fipping eBook in unadorned style, which you can even use to show your eBook

without the bottom toalbar, so that all of the attention will be focused on your eBook content, OF course, you can insert @ proper
background image to deep the impression of your audience too.

Templates =l
~ S e
= EimEsE
[ Meat ! =
[F@ spread — =

Colorful

B

— e —
Dazzie Florid Fiow-red u
1I 10

Refresh | | Remove The Template | [ Remove The Theme | Remove functions nesds Addministrator rights! [E Cancel

There are 4 templates for you to choose: Classical, float, neat and spread.

Classical:

Blues Colorful

Dazzle Florid Flow-red

Blank Blues Colorful

Dazzle Florid Flow-red
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Neat:

Black Pattern Blank Light Shadow

Official Blue Official Red Romantic Pink

Spread:

Colorful

(2) Click E icon to save the template setting for later use;

(3) CIické icon to import flash template setting;

2. Tool Bar Settings:

ElTool Bar Settings
HTitle Bar
[HButtons Bar

Tool Bar on top Falzse
EButton Icons

(1) Title Bar
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ElTitle Bar
The Book Logo C:\Wsers\Public\Pict. ..
Lego LIRL
Book Title www.,FlipBuilder .com
|| Page Number Box ... |False |

@ Choose a logo (Image or SWF only) for your flipbook;
@ Define the logo URL;

@ Define a title for the flipbook (This value accept HTML format text. For example:

<a href="http://www.flipbuilder.com' target='_blank'>FLIPBUILDER.COM</a> | <font

color="#ff0000' size='14'>Red Color</font>);
@ Decide to make page number box on bottom or nor.

(2) Button Bar

| BlButtons Bar
EHHome Button
Full Screen Button  |Show
[FHelp Config
FHPrint Config
HDownload setting
HSound
[HZoom Config
Hsearch
Hshare
[ Auto Flip
Thumbnail Button  |Enable
[ Single Page
HLanguage
Tool Bar on top False

@ Home Button

| EHome Button
Home Button Visible Hide
Page URL
Open Window Self

Show/hide home button and set home page URL; decide to open window in self or

blank window.

@ About Button

Elabout Button
Abouk Butkon Yisible | Hide
Contenk
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Show/hide about button and define content such as company file and contact info.

@ Full Screen Button

| Full Screen Button Shaw "

Show/hide full screen button; click E icon to view the flipbook in Full Screen, click

icon m or "Esc" button to exit from the Full Screen.

@ Help Config

| ElHelp Config
Help Button Show
Help Content File
Help Window Width 400
Help Window Height 450
Show Help At First Hide

Show/hide help button; choose the help content file (image and SWF only); define
help window width and height; choose to show/hide help at first.
The help content file will show you manual of this software, if you leave it empty,

default help content will show up.

@ Print Config

¢ e —— "

‘l BlPrint Config ‘

Print Enable fes
Print Watermark File

Enable/disable printing function; define watermark file (image and SWF only) to

be printed out. Click icon to print out the flipbook.

@ Download Config

Download Enable Mo

| BlDownload setting
Download URL

Enable/disable to download the flipbook; define the download URL. Click

icon to download the flipbook.
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@ Sound Settings

| BlSound
Enable Sound Enable
Sound File
Sound Loops -1

Enable/disable background sound; select background sound from your
computer; set sound loops (set"-1" to play the sound all the time while viewing

the flipbook).

icon stands for "sound on"; nstands for "sound off".

Zoom Config
| ElZoom Config
Zoom in enable Yes
Scroll with mouse Mo

Enable/disable zoom function: Clickmicon to zoom in; cIickm icon to zoom

— G .
out. In the float template, you can also use to adjust

the page size.

Choose to scroll with mouse or not.

@Search Function

ESearch
Search Button Show
Search Highlight Color | Il 0x408080
Least search charac...|3

Choose to show search button, then you will see the search buttonm in the
tool bar (make sure you have checked "Enable Search" option in "Import PDF"
interface); define highlight color and the least search characters; click the search

button and you will see the popup search window, type the search words and

cIickE, then you will find the wanted content.

@Share
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Elshare
| Share Button
Sodal Share Button | Show

@ Share Button:

| BlShare Button |
Share Button Show
Email Subject
Email Body {ink}

Choose to show the share button, then the e-mail share button Ewill

show up in the tool bar, your readers can share your flipbook with others via
e-mail if they enter the e-mail link with subject.

€ Social Share:

Social share is very useful to make your flipbook shared. Choose to show social

share, the social share button mwill show up. Your readers can share your

flipbook with their families and friends via Facebook, Twitter, Digg, Yahoo and

other social networks.

Social Share

[f] Facabook 3 Twitter
in Linkedin Google

B Del.icio.us ¥zhoo

B Diag T stumbleUpon

4y 8- Al
£ fve A Ask

E;j Reddit m Mixx

© Technorat + Maore

@ Auto Play
| Bauto Flip |
Enable fes
Flip Interval 3
Flay Count 1
Auto flip when startup |No

Select "Yes" to enable auto flip mode, click u icon to start auto flip. Define

the flip interval (seconds of staying on each page); then set play count to
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define how many times of auto play for the flipbook (-1 stands for continuous

play). Choose "Yes" or "No" to automate auto flip when start up.

@Thumbnail Button

|| Thumbnail Button Enable  v|

Enable thumbnail button, click the thumbnail buttonﬁto view the page

thumbnail of the flipbook. See below the thumbnail interface:

== Thumbnails

@ Single Page
‘ ElSingle Page
Enable Single Page Enable
|| Show Defaultly False |

Enable/disable single page to see the flipbook in sigle page or two spread

pages. Click D icon to view the flipbook in single page; click micon to get

back to the normal two spread pages mode.
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@ Language Settings

| ELanguage
Language English;Chi.ﬂ
Switchable Mo

CIick'ﬂicon to enter the language selection interface:

Language Serting ]

You can new or edit a language for the flash fipping book, The Labled calumn below is the string that wil be displayed in the
flash. The lanquage will be list in the fiash tempiate settings.

All the checked language on the left, wil be pushed to flash book when publish. The first checked language o the tog will be
the default lanquage in i baok, You can paint a lanquage to the published fipping-book by specify in the address like

L hrttp: /. XXX, commybook. html?pageindex=48lang =Japanese
Lauangues
] Engish I B saveas... | | (33 Load... | | [ Eait |
& chinese Language Settings
[¥] French
S Label Labeled
[ Arabic
e First Button Premiére page
e il Next Page Button Page suivante |=
Ll Greek Last Button Derrigre page |
[ Hebrew Previous Page Button Page précédente 1
[ rtalian Downioad Button Télécharger
=) - Print Button Imprimer
= L Search Button Recherche
B Portigues Clear Search Button Clear
[] Portuguese Book Mark Button Marque page
Help Button aide
Enable FullScreen Button Plein écran
Disable FullScreen Button Fenétre
Sound On Button son
Sound Off Button Muet d

Define the language for the flipbook, or you can choose two or more
languages and choose "Yes" for language switchable option, then you and

your readers can select the preferred language while reading the flipbook by

clicking the |Jicon.

Click . to create a new language; click R to remove the selected
. | Edit _ _
language; click who edit language item.

@Tool Bar on top

|| Tool Bar on top False |

In the float template, you can choose "True" for "Tool Bar on top", the tool
bar will show up on the top of the flipbook.

16 Button Icons

| HEutton Icons
|| Icon Colar
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Click 'ﬂicon to enter the color selection interface, choose color for the icons.

3. Flash Display Settings

|E| Flash Display Settings
Background Alpha 1
Retain the book to center | Yes
EFont
Initial Show Mone
Show Corner Flip Effect False
HBadkground Config
Flash Window Color Bl 0454545
Page Background Color W[ siiiiis
[HEook Proportions
[HEook Margins
HPage shadow
Hide Book Frame Bar Mo
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6
HPage Mumber
HMinime Style

(1) Background Alpha

| Badkground Alpha ]

Set the value of alpha (0 to 1) to control the transparence of the background
in flip book.

(2) Retain the book to center

| Retain the book to center  |Yes j
Set "Yes" to retain the flipbook in the center of the window, if you choose
"No", the flipbook will be on the right side.

(3) Font Settings

ElFont
HEButtons
HTitle and Windows
EHBookmark
Hsearch

You can choose font color and font type for the buttons, title and windows,

bookmark and search result panel.
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(4) Initial Show (Float and Spread templates only)
You can set initial show for bookmark and thumbnail, which will show in the
left panel.

(5) Show Corner Flip Effect

|| Show Corner Flip Effect !True j|

Set "True" for "Show Corner Flip Effect”, then you will see the flip effect at

the corners.

BIG BEST PRICE

e 4

s

Puawered by Fiiphulldas ok

(6) Background Config

| ElBackground Config
EHBackground Color
EHBackground

@ Background Color

| ElBackground Colar |

Gradient Color & CJoxFFFFFF
Gradient Color B [CloxFFa0FF
Gradient Angle 90

Define background color with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle
between two colors.
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@ Background Image

‘ ElBackground
Quter Background File

| Background position  |Scale to fit ﬂ
Inner Background File  |D:‘program. ..
Backaround position Scale to fit

Choose background images for outer and inner backgrounds from your

computer:

And you can define the image position to fit the window scale:

Scale to fit
Fl
Top Left

Top Center

Top Right
Middle Left
Middle Center
Middle Right

(7) Flash Window Color

| Flash Window Color 01010 10 JE|

Choose color for flash window such as the book window, "Help" window,
"Print" window and so on.

(8) Page Background Color

|| Page Background Color Jl

When loading pages, or if the page number of your PDF file is odd, the page (the
last page) will show with the "Page Background Color".

(9) Book Proportion
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ElBook Proportions
Fage Width 540
Page Height 720

You can define width and height for the flipbook.

(10) Book Margins

| ElBook Margins
Top Margin 10
Bottom Margin 10
Left Margin &l
Right Margin &l

Set parameter for the book margins such as top margin, bottom margin, left

margin and right margin.

(11) Page Shadow

| BlPage Shadow
Left page Shadow 90
Right page Shadow 55
Page Shadow Opadty 1

The value also takes the value of Book Proportions as reference, and the

value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow

color.
(12) Hide Book Frame Bar

i Hide Book Frame Bar fes LI

If don’t want to show the book frame bar, choose “Yes” in this option.

(13) Right to Left

If the language of your file is read from right to left (such as Arabic), then

choose "Yes" in "Right to Left" option.

(14) If you want your book in hard cover, you can enable "Yes" for hard cover,

and you will see the hard cover effect.
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(15) Flipping Time

|| Flipping Time 0.6
Sets page flipping time in seconds according to your needs. (Recommended
value is 0.6)

(16) Page Number

| BlPage Mumber
Start Page Mumber (Roman) |0
Start Page Mumber (Arabic) [0

Define the start page number as you like. For example, the first 3 pages are
Table of Content

pages with Roman page numbers, and set Arabic page numbers from page 4,
then you will get

page number box like below:

| Bpegehumber [
| StartPage Mumber (Roman) |0 ‘

[ Start Page Mumber {Arabic) |3 [
\Front Cover Page: |

Pages:
\The Fourth and Fifth Pages: |
-
(17) Minime Style
| EMinime style

|Jse Minime Style Yes

Width 400

Height 300

If you don't like the tool bar present in the flipbook, you can choose the
Minime style to

hide the tool bar.

4. Flash Control Settings
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|E|Flash Control Settings
Security Settings
HLinks
Google Analytics ID

(1) Security Settings

| Security Settings J"
If you don't want others to view your flipbook, you can add password to

protect your

publication. CIickﬂ to enter into the security config interface.

.E. Flash Security Config ' l&]

Mote:
Single Password option means that users need the password to view the flash book.

Exclude Front Pages option is to set a page number, all latter pages can'tbe
viewed without inputting password.

Security Type

@ No Security

| |
AN
= | Single Password:

Protect Page Range

o] o= ]

Add password to retain access authorization. You can define to protect all

pages or set page

range.
(2) Links
| BlLinks
Maouse aver color M 0500030
Link alpha 0.2
Open Window Blank
Enable after zooming in Enable

If you have check "Import links" option in "Import PDF" interface, or add links in
"Edit Page" interface, then you can define settings here, choose "Mouse over
color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0"
stands for the area is totally transparent), and "Open Window->Blank/ Self". The
links also can be clicked after zooming by setting "Enable after Zooming

in->Enable".
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(3) Google Analytics ID

ot o — it [ —— |

| Google Analytics ID." | |

In the HTML output format, you can add statistics by using google analytics. You
can get more information about Google Analytics ID from the below site:

http://www.google.com/analytics/ .

Bookmark Setting

Design Setting | Bookmark

eEe s ML X
¥ou can setup bookmarks here

[Title
= Introduction of Flip B ook Maker...
Introduction

= Software Features
[¥]

Qluick Import with Easy ...
_____ Flexible Output Options;
FIiFlFlirlg Book, Features

Fl
1
2
= Features K]
3
3
3

If there is bookmark for your flipbook, you can import bookmark directly by

[

clicking ™" icon.

If you don't have an existing bookmark, you can add bookmark manually. Click
Lqe to add

titles, and click to add sub-titles, define page number for the title at the
bottom box and

apply change.

Title: Multiple templates to s

Page: 4

Click * and ¥ to move up/down the title. Click Hto export the

bookmark.
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Application Options

1. Render Engine

Click "Options"->"Application Options" to enter into the below interface
':ﬁ. Options i ﬁ‘

Render Engine | Creata Mabile Version ‘

Please selecte a render engine for the conversion

@ SWF

[ G5 =
) GPL Ghostscript Dowload Ghostscript
r
[ LI ] -
7 Inner Library
i |
SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality |
Inner Library: Faster convert speed
=

Select a render engine for the conversion:

SWF: Much legible characters, smaller output size;
GPL Ghostscript: Higher color transfer quality;
Inner Library: Faster convert speed.

(Change option when PDF imported failed)

2. Create Mobile Version
@ Five types of page quality and size

Pages Quality and Size

Quality And Size:  |Higher guality larger file size -
Higher quality larger file size

High quality large file size

Medium quality medium file size

Low quality small file size

Lower quality smaller file size

High values ¢

T require m

@ Mobile template name

Mobile template name

Mame: [Sllde - ]

Sinile Paie Flii
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This program provides two mobile template modes: Slide and Single Page

Flip. You can choose you favorite mode.

Output Option

After all settings are done, click "Apply Change" to save settings. Then you can

‘\:ﬁ Convert To Flipping Book
publish the flipbook. Click icon to convert the PDF to

flipbook and the output option interface will show up.

‘i Output Option - [&J
Output |
Output type

»j’,} @ =himl &=z ".é&% bt " B

[¥] also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

@ How to make created eBooks available for others online?

Path I
Output Folder: E:\S flip programs manual\Manuals for Flip Book Ma Browse... | Open

File Name: index html i
Options l

HTML Title: 1 [ Advanced
I

[Fleurn to
= |
...... HLD DVDRAM ASD
|
Mak: utomatically play the fipbook D
LConvert [ Cancel
—
1. HTML

Y o=bm

This output type is for uploading created page-flipping ebook onto websites.
You can define HTML
Title and other properties by clicking "Advanced" button:

Options

HTML Title: demao T ﬁdvanced]

Set Keywords, Description or even Script in the below interface:
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1§ Advanced Settings ﬁ
HTML Advanced Settings 1
HTML Meta Settings

Title: demn

Keywords:  pdf, fipbook, page-fipping, eback, online, website, flach, background, music

Description:  [his page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Saripts
You ean put some tracking
«code such as Google
Analytics here,
Need dosed <saipt>tag!
==

2.ZIP

= s * 5

Sls @ ap

5

This output type is for compressing the created files into an integral ZIP
package which can be

sending out as attachment directly. You can also define HTML Advanced
Settings by clicking

"Advanced" icon. Your recipients just need to uncompress the ZIP file and
then they can view the

HTML flipbook instantly:

files

\?_, demo.html

book.swf

Uncompress
3. EXE

e“é;.%l @ *.exe

This type is for outputting flipbook as a single executive file, easy storing and
easy viewing:

<

demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
’EAdvnncedScttings Eﬁg1

Exe Advanced Setfings

Exe Windaw Info

Caption; dema
Teon: d!ﬁll wo | | pefadt |

Window Size Option
Maxmized Custom Size

© Full Screen

Cee ] [omat ]

4. APP
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afi =
‘ ) *.app

If you want to make executable application to run on Mac devices, you can
output as "*.app" format.

5. Mobile Version

: [¥] also Make Mobile Version |

You can even output Mobile Version while choosing HTML or ZIP format at the
same time.

After creating mobile versions, you just need to output all files online
(including HTML, SWF, "files"

and "mobile" folders), then you can visit the flipbook page through your
mobile browser.

6. Burn to CD

[¥] Bucn to €D

CD Writer |D: 1:0,G: PLDS  DVD-ROM DH-16D55 VD15 =

Disc title: Page-Flipping eBook
[¥] Make it automatically play the fliphook in CD

After choosing output type, then check the option "Burn to CD", set "CD
Writer", define "Disc title".

Batch Convert Mode

(% Batch Convert
Click to batch convert multiple PDF files to flipbook

S

Add Files

ks
1. Click % to add two or more PDF files;

2. Click Q:, Add Folder

3. Choose output format and define output settings as the above mentioned.

to import PDF files from the folder;
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Command Line Mode

Flip Book Maker for PDF Pro also provide another conversion mode—Command
line mode, which can automate the conversion, and in this way, you can also
publish an interactive virtual flipbook with impressive page flip effect.

See below the command line mode:

Flip Book Maker for PDF Professional Command Line Usage:
PTCMD.exe [Options]
-f<PDF File> The source PDF file.
-o<output folder> Specify the folder for the output files.
-t[html|zip| exe] Output type. Default is html.
-n<OutputFileName>  Specify the name for the output file.
-c<caption> Caption for HTML or EXE.
-s<Flash settings> Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.

<txt_settingfile path> is the file that you export

with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

-g<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render

engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)

-I<Y|N> Import links yes or no. (Default: Y).
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-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)
-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf"  -o"C:\outputfolder" -n"index" -tzip -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N R WNRE
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